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PowerTerm Series Terminal 
Emulation - PowerTerm Lite, Plus, 
InterConnect, Pro, and Enterprise 
INSTALLING/UNINSTALLING, UPGRADING 
OR MOVING POWERTERM 
1. Including 'Terminal Type' & settings in an icon or script 

How do I configure PowerTerm icon to run a script or settings file? 

Sometimes it is useful to be able to make a connection and have the program commence 
operation already in a designated emulation type with various saved parameters. This is 
easy to do.  

First you must select the emulation and other parameters you want and save them via the 
"Save Terminal Setup as" choice from the File menu. Example: sco.pts 

From an icon 

If you want to be able to include terminal type & settings from an icon, click here to 
download it. and copy script into the PowerTerm directory. 

Then make a shortcut or program item and supply the following parameters on the target 
line: 

example: ..... telnet2.psl xxx.pts myhost 

where myhost is the host name or IP address of the host you are trying to connect to. 

From a script 

For other users, you would just make a copy of your ‘comm.psl’ [for modem use], ‘tn5250.psl’ 
[for AS400 use], etc., and place this line: 

open-setup-file xxx.pts 
where ‘xxx.pts’ is the name of your new setup file. (This line must be the first line in the 
script.) 

Then make a shortcut or program item (as explained above) and supply the needed 
parameter hostname. 

example: ..... telnet.psl myhost 

http://sc.ericom.com/demos/telnet2.zip
http://sc.ericom.com/demos/telnet2.zip
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2. Release Notes 

What are the new features of the latest releases? 

Follow these links to learn more about the feature updates for PowerTerm’s latest version 
releases. 
 
PowerTerm WebConnect Editions: 

• PowerTerm WebConnect - Windows EditionPowerTerm WebConnect - Linux Edition  

PowerTerm InterConnect Editions: 

• PowerTerm InterConnect - Windows Edition  
• PowerTerm InterConnect - Mac OS X Edition  
• PowerTerm InterConnect - Linux Edition  
• PowerTerm Plus  
• PowerTerm Lite  

PowerTerm Pro/Enterprise  
 
PowerTerm Host Publisher (v5.2) 

CONNECTION AND HOST CONNECTIVITY 
ISSUES  

1. Creating a desktop icon for PowerTerm session 

How do I create a desktop icon for instant connectivity to my host? In order to generate a 
desktop icon for PowerTerm session, please follow the steps below: 
 
1) Run PowerTerm 
2) Connect to the desired host. 
3) Click on the Files menu -> Save As Icon 

2. Terminal ID 

I need to specify a Terminal ID which is not listed in the Display tab (Terminal -> Setup 
window). Which other ways may help me do this? 

If you need to set the ‘Terminal id’ to a name which is not available in the pulldown list of 
the Terminal -> Setup ->General -> display, you can set this parameter on the 
Communications->Connect screen as a Telnet option. Additionally, you can use a PSL script 
command: 

• set terminal-id NAME 

where ‘NAME’ is the string you want to use. 

http://sc.ericom.com/logJava.asp
http://www.ericom.com/logJava.asp#5.6Linux
https://sc.ericom.com/logIC.asp
http://sc.ericom.com/logICMac.asp
http://sc.ericom.com/logICLinux.asp
http://www.ericom.com/logPlus.asp
http://sc.ericom.com/logLite.asp
https://sc.ericom.com/logpro.asp
https://sc.ericom.com/loghostpub.asp
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3. Setting modem baud rate (speed) 

How do I set the modem baud rate? 

Baud rate is easily chosen from the pulldown list of speeds in the Communication -> 
Connect window after you select the COM choice (Session Type list). 

It is possible that the speed of your modem will not appear in the list.  In such case, simply 
select the next higher speed on the list. 

4. 'Session Type' - Requirements & Troubleshooting 

What are the requirements for the various session types? 

Session 
Type 

Protocol PC Requires... Host Network Emulation 
Type 

Troubleshooting 

Telnet TCP/IP 16-bit: 
WINSOCK.DLL; 
32-bit: 
WSOCK32.DLL 

VMS + UNIX N/A VT + Non-
IBM 

Check 
Ping/Telnet 

COM & 
(RS232) 

N/A N/A VMS + UNIX N/A VT + Non-
IBM 

Check with 
Hyperterminal 

INT14 BIOS 
INTT14 

N/A VMS + UNIX N/A VT + Non-
IBM 

N/A 

BAPI TCP/IP BAPI Support VMS + UNIX N/A VT + Non-
IBM 

N/A 

CTERM DEC 
CTERM 

Pathworks (v5.0 
- v6.0) 16-bit: 
TRMNLAXS.DLL; 
Pathworks (v7.0) 
32-bit: 
DECTAL.DLL 

VMS N/A VMS Same bit version 

LAT DEC 
Local 
Area 
Transport 

Pathworks (v5.0 
- v6.0) 16-bit: 
TRMNLAXS.DLL; 
Pathworks (v7.0) 
32-bit: 
DECTAL.DLL 

VMS N/A VMS Same bit version 

Rlogin TCP/IP 16-bit: 
WINSOCK.DLL; 
32-bit: 
WSOCK32.DLL 

UNIX N/A UNIX Check 
Ping/Telnet 

TN3270 
& 
TN3270e 

TCP/IP 16-bit: 
WINSOCK.DLL; 
32-bit: 
WSOCK32.DLL 

MAINFRAME N/A IBM 3270 Check 
Ping/Telnet 
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MS SNA Microsoft 
SNA 
Client 

Winappc MAINFRAME 
+ AS400 

NT 
SERVER 

IBM 3270 
+ IBM 
5250 

Check the SNA 
Client Applet & 
same bit version 

NW SAA IPX N/A MAINFRAME NOVELL IBM 3270 v1.3b or later 
gateway; must 
connect & 
specify a user 
name that does 
not have a 
password for 
3270 

NW SAA TCP/IP N/A MAINFRAME NOVELL IBM 3270 N/A 
TN5250 TCP/IP 16-bit: 

WINSOCK.DLL; 
32-bit: 
WSOCK32.DLL 

IBM AS/400 N/A IBM 5250 Check 
Ping/Telnet 

APPC APPC NS/Router 
16-bit: 
EHNAPPC.DLL; 
32-bit: 
E32APPC.DLL 

IBM AS/400 N/A IBM 5250 Same bit version 

 
   

5. Creating PowerTerm shortcuts manually 

How do I autoconnect via Telnet, using an icon on the desktop? 

In order to create a desktop shortcut please follow the steps below: 

1) Use "My Computer" or "Explorer" to view the PowerTerm Directory. 
2) Look for the PowerTerm executable, ‘ptw32.exe’. 
3) Right-mouse-click on this item and choose ‘Create Shortcut’. A new icon will appear. 

(You may rename this if you like.) 
4) Drag this new icon onto the Desktop. 
5) Right-mouse-click on it again and choose ‘Properties’. 
6) Select the ‘Shortcut’ tab and then modify the ‘Target’ line: 

..... ptw32.exe 
Simply add ‘telnet.psl’ and the host you want to telnet to. 

example: 

..... ptw32.exe telnet.psl myhost 
where myhost is the name or IP address of the host system you are trying to connect to 
Important Note: 
If you see quote marks around the text on the target line, place the new words OUTSIDE of 
the quotes, so you will have a target such as 
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"C:\Program Files\PTW32\ptw32.exe" telnet.psl myhost 

 

6. SNA Gateway 

How do I connect to my AS/400 via SNA gateway? 

PowerTerm cooperates with Microsoft’s WINAPPC.DLL or IBM’s EHNAPPC.DLL (16-bit only) 
to make the connection to the AS/400. The connection to AS/400 via Microsoft SNA server is 
done through APPC, and can be handled by either Microsoft’s WINAPPC.DLL or IBM’s 
EHNAPPC.DLL.  (You  must have either Client Access or Microsoft SNA client installed and 
configured on your PC.) 

To connect to your Microsoft SNA server with APPC using PowerTerm, 

1) Go under Terminal|Setup|Emulation, select 5250 display, and click OK. 
2) For WINAPPC.DLL: Select the MSSNA option under Communications|Connect. 
3) For EHNAPPC.DLL: Select the APPC option under Communications|Connect. 
4) Fill in the appropriate parameters. 

7. Auto-connect via modem with a desktop shortcut 

How do I configure desktop shortcut to connect automatically to the host via modem? 

In order to create a desktop shortcut: 

1) Use "My Computer" or "Explorer" to view the PowerTerm Directory. 
2) Look for the PowerTerm executable, ‘ptw32.exe’. 
3) Right-mouse-click on this item and choose ‘Create Shortcut’. A new icon will appear. 

(You may rename this if you like.) 
4) Drag this new icon onto the Desktop. 
5) Right-mouse-click on it again and choose ‘Properties’. 
6) Select the ‘Shortcut’ tab and then modify the ‘Target’ line: 

..... ptw32.exe 
At the end of this line, simply add ‘comm.psl’ followed by: 

1) the COM port your modem is connected to. 
2) the baud rate you want 
3) the protocol type (select from ‘none’, ‘xonxoff’, or ‘hardware’) 
4) the phone number to dial 

example: 
..... ptw32.exe comm.psl 2 19200 xonxoff 508-234-7531 
Important Note: 
If you see quote marks around the text on the target line, place the new words OUTSIDE of 
the quotes, so you will have a target such as 
"C:\Program Files\PTW32\ptw32.exe" comm.psl 2 19200 xonxoff 508-234-7531 
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8. Call back from a remote host 

How do I automate call-back procedure from a remote host? 

It is sometimes necessary to dial in to a remote host which then auto detects you and calls 
back to establish a connection. Here is a sample comm.psl script which automates this 
process, putting your modem into auto answer mode: 

... ... 

... 
if {$pc <1} 
message "Script COMM.PSL must have at least 1 parameter" 
return 
} 
set comm-type com 
set port-number $p1 
if [info exist p2] { 
set baud-rate $p2 
if [info exist p3] { 
set protocol-type $p3 
} 
} 
session open 
run keys.psl 
send "ATS0=1^M" 
if [info exist p4] { 
send "ATDT$p4^M" 
} 
This script assumes that the remote host auto detects you, initiates the hang-up and then 
calls back. Include any special modifications for your particular host at the end of the script. 
For example, if you need to wait 10 seconds after connecting and then hang-up on your 
end, include the following lines: 
... 
... 
wait 10 seconds 
send "+++ATH" 

9. Device Naming for AS/400 hosts 

I have problem naming devices on my AS/400.  
 
PowerTerm allows to name devices during 5250 sessions. You are able to print AS/400 jobs 
to a local PC printer, using all the controls available to printers connected directly to the 
AS/400.   
 
However, there have been problems depending on the AS/400 operating system.  If the 
AS/400 has a CISC operating system, 3.2 will work.  If the AS/400 has a RISC operating 
system, 3.2, 3.7,4.1 or 4.2 will work.   In any case, if the operating system is different from the 
supported version, a patch can be obtained from IBM to upgrade to a workable version. 
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10. SSH connection with private keys 

How do I configure PowerTerm to use private SSH keys during the connection to the host?  
Please follow the steps below: 

1) Use an application like the "SSH-keygen" in order to generate a pair of keys: private key 
and public key. 

2) Add the content of the new public key to the "authorized keys" file on the host. 
3) In PowerTerm’s "Connect" window: set the "security type" to "SSH" and click "Details" 
4) Set "Private key file for authentication" to the exact location of the private key generated 

in step #1. The private key does not have to be *.epk file. When doing so - PowerTerm 
will automatically create a new private key in EPK format. 

KEYBOARD, KEYBOARD MAPPING AND 
SCRIPT COMMANDS 

1. Mapping keys via 'drag-and-drop' or 'function button' 

How do I re-map keys via ‘drag-and-drop’? 

Here are examples of the types of key mappings you can do: 

1) The ‘Enter’ key on the numeric keypad of the PC should perform the function of the 
‘Do’ key on the VT220. 

2) The ‘F2’ key on the PC should send <CTRL>X. 
3) The ‘F7’ key on the PC should run the ‘ELM’ command. 
4) The ‘F9’ key on the PC should run send an ‘escape [ 2 3 

2. Backspace key configuration 

My Backspace key doesn’t work! 

This is because you will have to set the backspace key to send backspace or delete.   To do 
this, select the "Terminal" menu and choose "Setup" and select the "Keyboard" tab. Now 
choose the setting you wish in the "Backspace Key Sends" section. The key can send either 
Backspace or Delete. 

3. Function Keys 

Why don’t all my Function Keys work? 

The VT100 keyboard only has four functions keys (PF1-PF4) across the top of its keyboard. 
PowerTerm’s VT100 emulation maps PF1-PF4 to the F1-F4 keys. The remaining function 
keys have no meaning in the VT100 emulation.  
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4. Key re-mapping 

How do I re-map keys? 

PowerTerm supports three powerful and easy methods for mapping keys: 

1) Drag and Drop Key Mapping facility -- for ’simple’ mappings. 
With the Drag and Drop Key Mapping facility you can assign a key on your PC to 
perform the action of any (single) key on the terminal being emulated. 

2) ‘Function Button’ Box Key Mapping facility -- for ’complex’ mappings. 
3) Script language for ’simple’ or ’complex’ mappings. Using the script language, you 

can create any type of key mapping. 

5. Sending NULL to the host 

How to send NULL to the host?  

In order to send NULL to the host use the following PSL command: 
send ^@ 
 
This command can be used for all the character mode emulations.  

DISPLAY AND SCREEN\EMULATION DISPLAY 
ISSUES 

1. PowerTerm displays host application incorrectly 

My host application contains several screens, and one of them is not properly displayed by 
PowerTerm. What can I do?  
 
In correct display is typically a result of incorrect configuration. However, in case that the 
configuration is accurate, please contact Ericom support team and provide us with 
PowerTerm configuration files and PowerTerm log file for further investigation. 
 
In order to generate PowerTerm log file, please follow the steps below: 

1) Open the PowerTerm session in disconnect mode. If the session connects 
automatically, disconnect. 

2) Press Ctrl+Shift+S (The Status Bar displays: capture.log with send with keys) 
3) Connect to the host and recreate the problem.  
4) As soon as the problem has been identified, press Ctrl+Shift+S (The Status Bar 

displays: capture file end) 
5) Press Ctrl+Shift+M (The relevant log files will be attached to a new email message 

automatically) 
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LANGUAGES, SUPPORTED LANGUAGES, CODE 
PAGES AND CONFIGURATION 

1. Escape sequences to switch between languages (English - Hebrew) 

What are the ESC sequences that should be used in order to switch between Hebrew and 
English? 
For DG emulation: 
 /bin/echo "\036\026"        (to set language: Hebrew) 
 /bin/echo "\036\002"        (to set language: English) 
  
  
For VT emulation: 
 CSI ? 35 h        (to set language: Hebrew) 
 CSI ? 35 l        (to set language: English) 
  
Where CSI is: esc [ 

PRINTING, PRINTING THROUGH THE 
TERMINAL EMULATOR 

1. Printing Hebrew fonts 

Hebrew fonts are not printed by the new printer 

Please download this file (Example.txt) and print it from DOS command prompt. 
  
If the printing does not show the Hebrew fonts, it means that the required Hebrew fonts are 
not installed on the printer. In such case please check this with the 
printer’s manufacturer\provider. 

2. Auto Printing 

What is "Auto Printing" and how do I use it? 

 Auto Printing is the ability to print (on a locally attached PC or network printer) whatever 
appears on the emulator screen. To do this: 

1) First you must engage the Start Auto Print option in the File menu or press the Auto 
Print button on the toolbar. 

2) Next, the material you want to print should be passed onto the screen of the 
terminal. 

3) When the file or series of lines has completely passed over onto PC screen, choose 
the Stop Autoprint option in the File menu or the press the AutoPrint button on the 
toolbar. 

3. Mainframe and AS/400 printing 

http://sc.ericom.com/auxiliary/Example.txt
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How do I configure IBM printer sessions? 

1) To emulate an IBM printer in PowerTerm choose 3270/5250 printer. 
2) Connect using a printer name (LU or DEVICE name). When an application on the 

IBM needs to print it sends a print job to a printer by its name. If a 3270/5250 printer 
session is active (or there is a printer hardware) with this name, the data is sent to it 
and the printer session prints to the attached printer (local or remote - lpt1). 

PowerTerm now supports the newest IBM standard for Device ID naming & Printing for 
TN5250. In order to do this, you must have PowerTerm v5.2.2 or greater, and be running the 
appropriate patches or AS/400 operating system, in order for this to function properly. For a 
list of patches or OS level needed, contact Ericom Customer Advocacy at ca@ericom.com.  

However, you can still use APPC, which must be running on both the PC and AS400. An 
example of APPC on the PC is Client Access.   Another method is to have LPD running on 
your PC.  Because LPD is a separate application and is not a part of PowerTerm, please 
consult your LPD documentation to set this up. 

A very frequent problem report we get from customers is that a file named "E32APPC.dll" is 
missing. This means that the PC doesn’t have APPC, as explained above. 

1) Choose 5250 printer. 
2) Open the Connect dialog box and choose APPC. 
3) Enter the system name & device name. 
4) Press Connect. 
5) It should be connected to the AS/400 now as a system printer. 
6) The user should send printouts (print jobs) to the printer session by its device name 

specified in item (3) above. 

4. Define printing parameters 

How should I configure PowerTerm in order to print correctly? 

1) From the Terminal menu, select the Setup option. 
2) Select the Printer tab. 
3) Select the printer parameters that you require. 

a) Print Device: This option allows you to select a printing output channel. The 
possibilities are: 

Option Sends the Output 

None No destination was assigned. 

Print 
Manager 

Sends to the standard Windows 
Print Manager, in text mode. 

Device Sends to the DOS device you 
designate in the Device Name text 
box. For example, this can be a 
device such as prn, lpt1, com1. In 

mailto:ca@ericom.com
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the Device Name text box, you can 
also specify communication 
parameters. For example: 
COM1:9600,8. 

File Sends to the DOS file you type in 
the File Name text box. See the 
Device parameter below. 

b) Note: If you chose Print Manager or None as the option for Print Device, the 
Device File Name field will be disabled. 

c) Device: 

Device File Name: If a file of the same name exists, you can choose to add the 
new data to it, or to create a new file. You can do this using the File Creation 
parameters. To add the data, click the Append option; to create a new file, click 
the Overwrite option. 

d) Other: 

Use Form Feed: Adds a form feed (page eject) after each printing job, if you are 
printing to file. 

Print Line Graphics As Text: Converts line graphics to text. This speeds up 
printing on a slow dot-matrix printer. 

Print Screen Data Conversion: Converts data to IBM or Digital character sets. If 
you do not want to convert data, use the None option, or select Graphics from 
the dropdown list to print in Graphics mode. Selecting the Graphics option will 
always send a print screen via the Print Manager in Graphics mode, regardless of 
the print device. 

Slave Printer Data Conversion: Converts data to IBM or Digital character sets for 
slave printing. If you do not want to convert data, use the None option. Select the 
Graphics option from the dropdown list in order to print to a postscript printer. 

Slave Printer Job Delimiter: When printing in slave mode, the job delimiter 
character that you select here will divide the data into print jobs instead of 
escape sequences arriving from the host application. 

5. Slave printing 

How do I configure "slave printing"? 

"Slave Printing" means an automatic routing of an input data stream, such as a report, to 
the PC’s printer port. To enable slave printing, run the Terminal -> Setup ->Printer menu, 
and choose FILE. Since this type of printing is done directly to the printer port, you must 
specify as the filename which port the printer is on, such as ‘lpt1’. Then, select ‘none’ as the 
Print Screen Data conversion. (This form of printing is text only. We do not support slave 
printing to Postscript printers at this time) 
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To use this functionality, it is necessary to precede the data stream with an escape 
sequence, and to terminate the data stream with an escape sequence. 

1) For VT and SCO emulations: 
a. enable: <escape>[5i 
b. disable: <escape>[4i 

2) For Wyse 50/60 
a. enable: <CTRL>R 
b. disable: <CTRL>T 

6. Transparent printing in Wyse emulation 

What are the escape sequences required for transparent printing? 

"Transparent Printing" functions the same as "Slave Printing", however, the data will not be 
viewable on the screen. 

1) Wyse Transparent Print Mode On: <escape>d#  
2) Wyse Transparent Print Mode Off:<ctrl>T 

7. Postscript printer 

What is the recommended configuration for post-script printers? 

Postscript printing enables one to either print the data currently on the screen or use slave 
printing to print to a Postscript printer.  
 
Postscript printing is enabled by setting Slave Printer Data Conversion option to Graphics. 
This is done in the Terminal -> Setup menu -> Printing tab. If this is the case then slave 
printing to a postscript printer will work whether Print Device is set to File, Device, or Print 
Manager.  

However, if the Slave Printer Data Conversion option is set to none and Print Device is set to 
File, slave printing will fail and PowerTerm will appear to be hung. Screen printing to a 
Postscript printer will be successful if Print Screen Data Conversion is set to Graphics in the 
Terminal -> Setup menu -> Printer tab. 

8. Advanced Printing - 5250 Printer parameters 

How to define AS400 TCP/IP printing? 

1) From the Printer properties page, click the Advanced Printing button. 
2) Select the Enable Host Print Transform check box. 
3) Select the manufacturer printer type and model from the Printer Type/Model 

dropdown list. 
a. If ‘Other Printer’ is selected for Printer Type/Model: 
b. Specify the Customizing Object. 
c. Specify the Customizing Object’s Library. 

4) Select the paper size from the Drawer 1 dropdown list. 
5) Select the paper size from the Drawer 2 dropdown list. 
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6) Select the paper size from the Envelope Hopper dropdown list. 
7) Specify whether the printer has Code Page 899 installed in the Supports ASCII Code-

Page 899 field. 

Special Notes about the selection areas: 

Enable Host Printer Transform: Enables Host to send to the emulation the printer specific 
format commands. If disabled, the Host sends general format commands in which the 
emulation in turn, translates to printer specific commands. Host Printer Transform is only 
relevant for non-graphic mode. 

Printer Type/Model: Specifies the destination printer. The default is: HP LaserJet Series ll. If 
your manufacturer Printer Type and Model are not listed, then choose one that is 
compatible. 

Customizing Object: Specifies the object name which you had previously defined on the 
AS/400. 

Library: Specifies the customizing object’s library on the AS/400. The above fields are 
applicable when you have first defined a customizing object for your printer on the AS/400. 
Choose Other Printer from the Printer Type/Model dropdown list and the Customizing 
Object and Library fields become enabled. 

Drawer 1: Specifies the size for the paper in Paper Source 1. The default depends on what 
you chose for the Printer Type/Model. 

Drawer 2: Specifies the size for the paper in Paper Source 2. The default depends on what 
you chose for the Printer Type/Model. 

Envelope Hopper: Specifies the size of the envelope. The default depends on what you 
chose for the Printer Type/Model. 

Supports ASCII Code-Page 899: Specifies whether the printer has Code Page 899 installed. 
The default is: disabled. Most printers do not have Code Page 899 installed. 

Font: Specifies the name of desired font. The default is Courier-10. 

9. 'Advanced printing' and 'Host Print Transform' 

How do I define Non-5250 printing parameters? 

1) In Text mode: Text mode is designated in the Printer Tab by setting the two data 
conversion combo boxes (Print Screen and Slave Printer) to None. 

a. LPI, CPI, & Fonts are functional. LPI: Lines Per Inch (default is 6). CPI: 
Characters Per Inch (default is 10). 

b. Printer Rows & Printer columns are non-functional. 
2) In Graphics mode: Graphics mode is designated in the Printer Tab by setting the two 

data conversion combo boxes (Print Screen and Slave Printer) to Graphics. 
a. LPI, CPI, & Fonts are non-functional. 
b. Printer Rows & Printer columns are functional. 
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10. 'Printer Not Found' error message (v5.07 or older only) 

PowerTerm printing seems to have stopped working. How can I fix it? 

If you have been using PowerTerm printing successfully and then the printing seems to 
have stopped working, take a look under File -> Printer Setup.  You should get the message 
"Printer Not Found".  To fix this, you will need to do the following: 

1) Close all PowerTerms 
2) Go into your Windows directory 
3) Delete the 3 files, Ptw.cfg, Ptw.prt_1.cfg and Ptw.prt_2.cfg. 
4) Start PowerTerm. 

11. Printing to a serial printer (COM port) 

How do I configure PowerTerm to print to a serial printer (COM port): 

There are three ways to print to a serial printer: 

1) Most recommended way: Print Manager 

a) Terminal -> Setup -> Printer tab 
b) Set Print Device to "Print Manager" 
c) Click on "Advanced Printing" button and set the "Printer Type\Model" to one of the 

dot-matrix printers on the list (for example one of the DFX printer types). 
d) Save the changes and select the desired port. 

2) Aux: 

a) Terminal -> Setup -> Printer tab 
b) Set the "Print Device" to "Aux" 
c) Click OK 
d) Communications -> Utilities -> AUX: Modify Connection 
e) Select the desired COM configuration 

3) Print Device - COM 

a) Terminal -> Setup -> Printer tab 
b) Set "Print Device" to "Device" 
c) Type the desired port ("Device Name") - For example: COM1 
d) Click OK. 

GUI CUSTOMIZATION, USER INTERFACE 
CHANGES 

1. Prevent the user from restoring the main menu 
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I have configured PowerTerm to hide the main menu. However, the user restores the 
menu by the right clicking PowerTerm icon on the task bar. How can I prevent this? 
In order to prevent the user from restoring the PowerTerm main menu, please add 
the following parameter to PowerTerm’s shortcut: 
  
-always-no-menu 
  
This parameter can be also applied to all the users very simply by following the steps below: 
  
1) Create with notepad a file called ptargs.ini  (case sensitive!). 
2) Add the command: -always-no-menu to the file. 
3) Save and exit. The ptargs.ini file should be saved to PowerTerm’s working directory (next 
to ptw32.exe). 

2. PowerPad and Softkey programming 

How do I program PowerPad and Softkey using PSL script? 

PowerPad 

The PowerPad is set up like a grid. You need to specify the row and column of the entry you 
want to program. The label of the button must be double-quoted and the function of the 
button goes after the "send". 

Here are examples of programming them in a script: 

1) pad 1 1 "ELM" {send elm^m} 
2) pad 1 2 "DATE" {send date^m} 
3) pad 1 3 "F3" {send <f3>} 
4) pad 1 4 "F4" {send <f4>} 

Softkey 

The softkeys are labelled "F1", "F2" .. "F12" buttons at the bottom of the PowerTerm window. 

Here are examples of programming them in a script: 

1) func 1 "ELM" {send elm^m} 
2) func 2 "DATE" {send date^m} 
3) func 3 "F3" {send <f3>} 
4) func 4 "F4" {send <f4>} 

3. Using menu commands in script 

How do I remove or activate menu items using a PSL script? 

 Almost every menu command which can be executed with the mouse can be run from 
within a script. (Menu Commands which require typing or which product a choice-list 
cannot be run from scripts.) 
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The script command is: activate-menu-item <command> 

where <command> is one of the following list: 

  

In order to remove menu items, please use the following command: 

remove-menu-item <menu-item> 

For example: 

remove-menu-item Setup  

4. Removing GUI components (Menu, Toolbar, etc.) 

How do I remove the menu and the toolbar?  

There are several ways to remove GUI components: 
1) Run PowerTerm and click on the desired items of the Options menu (Hide Menu, Hide 
Tool Bar, Hide Buttons..). 
In order to save these new settings for future sessions, click on Files -> Save Terminal Setup. 
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2) Command line parameters (Linux) or shortcut parameters. 
For example, add to the Target line of PowerTerm’s shortcut: 
-no-menu -no-toolbar 
 
On Windows: 
"C:\Program Files\Ericom Software\PowerTerm\ptw32.exe" -no-menu -no-toolbar 
 
On Linux: 
./PowerTerm -no-menu -no-toolbar 
 
3) ptargs.ini file 
A) Create a new file named ptargs.ini and save it to PowerTerm’s working directory 
B) Add the following text to the new file that you have created in the previous step: 
-no-toolbar 
-no-menu 
-fullscreen 
-no-buttons 
-no-status-bar 
C) Save the change. 
 
4) PSL script 
For removing GUI components, use the PSL commands: 
set hide-status-bar on 
set hide-buttons on 
set hide-toolbar on 
 
In addition, PSL scripts allow you to remove undesired menu items or tool bar icons.  
For example, in order to remove the Setup menu-item, simply run the following PSL 
command: 
remove-menu-item Setup 
 

TRANSFERING FILES USING FTP OR OTHER 
PROTOCOLS 

1. Secure FTP - Automatic File Transfer 

How to automate the connection and file transfer with the FTP client? 

This file contains the instructions to automate the connection and file transfer with the FTP 
client.  
SCRIPTING, POWERTERM SCRIPTING 
LANGUAGE AND MORE 

1. The escape sequence required in order to receive the Answerback 
message 

http://sc.ericom.com/auxiliary/AutomaticFileTransfer.pdf
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What escape sequence do I need in order to receive the Answerback Message from the 
terminal emulation? 

 For DG emulation use the following PSL command: 

display \036we 
  
For VT emulation use the following PSL command: 
display \005  

2. Automatic Login 

How do I configure an automatic login process?  

PowerTerm can easily be setup to automate the login process, so that all steps necessary to 
login to a host computer can be activated via a script. Here are 2 sample login scripts, one 
for a modem connection and the other for a telnet connection:  

MODEM CONNECTION 
send "atdt1-212-872-8181^M" 
wait 30 for "CONNECT 9600" 
send "^M" 
wait 10 for "login:" 
send "joseph^M" 
wait 10 for "Password:" 
send "cotten^M" 

TELNET CONNECTION 
wait 10 for "login:" 
send "wesley" 
wait 10 for "Password:" 
send "snipes" 

In the above examples, 

1) The send command sends the following string to the host. 
2) The ‘^M’ means the caret character followed by the letter ‘M’, and it represents the 

newline/Enter key. 
3) The wait command causes the script to pause until the indicated string is received 

from the host. 
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3. PowerPad and Softkey programming 

How do I program PowerPad and Softkey using PSL script? 

PowerPad 

The PowerPad is setup like a grid. You need to specify the row and column of the entry you 
want to program. The label of the button must be double-quoted and the function of the 
button goes after the "send". 

Here are examples of programming them in a script: 

1) pad 1 1 "ELM" {send elm^m} 
2) pad 1 2 "DATE" {send date^m} 
3) pad 1 3 "F3" {send <f3>} 
4) pad 1 4 "F4" {send <f4>} 

Softkey 

The softkeys are labelled "F1", "F2" .. "F12" buttons at the bottom of the PowerTerm window. 

Here are examples of programming them in a script: 

1) func 1 "ELM" {send elm^m} 
2) func 2 "DATE" {send date^m} 
3) func 3 "F3" {send <f3>} 
4) func 4 "F4" {send <f4>} 

4. Advanced script programming 

Advanced script programming 

POWERTERM SCRIPT RULES 

1. PowerTerm Script language uses many ‘{‘ and not many ‘(‘ 
2. NO: if ( $variable == "hello" ) 

YES: if { $variable == "hello" } 
3. Variable assignment does not use a ‘$’. Variable reference does. 
4. NO: $var = $data 

YES: var = $data 
5. assignment ‘=‘ must be surrounded by whitespace. 

(tests need not be surrounded by whitespace -- ‘if {$var<=10}’ is acceptable.) 

NO: i=1 
YES: i = 1 

6. The ‘{‘ starting a block of statements MUST be on the same line as the ‘if’, ‘for’ ... 
statement. 
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7. YES: if { $data == 10 } { 
i = 45 
} 

NO: if { $data == 10 } 
{ 
i = 45 
} 

8. incrementing is interesting... 
9. use the ‘expr’ command which evaluates an expression, and the ‘[ ...]’ facility 

which replaces itself with the result. 

Thus, i = [ expr $i + 1 ] 
or, use the ‘incr’ command which increments its argument (and because there is an 
assignment involved, no ‘$’ is used. 
i = [ incr i ] 
.. or .. 
i = [incr i 3 ] # increment by 3 

10. ‘for’ loop syntax is tricky: 
11. as usual, there are 4 parts 

 initialization 
 test 
 increment 
 body statements 

ALL 4 PARTS ARE individually wrapped in ‘{...}’ 
AND -- as indicated above -- the ‘{‘ beginning the body statements MUST be on the 
same line as the 3 earlier parts: 

NO: for (i=0; $i <10; $i++) 
var = 45 

YES: for {i = 0} {$i <10} { i="[incr" i]} { 
var = 45 
} 

12. Testing for Time Outs in ‘wait’ Here is an illustration of a script which uses 
a wait statement and an if to test the result: 

13. str = [wait 10 for "hi there"] 
if {$str == "1"} {message "Hello to you"} else {message "no one home, $str"} 

For an unconditional wait, the ‘wait’ command can be used in this manner: 

wait 10 seconds # [always say ‘seconds’, even in ‘wait 1 seconds’] 

14. ‘wait’-ing for a string in a designated location The wait command can look for a 
string in a designated location, as in: 

15. wait 10 for "F1" at 23 70 
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This will wait 10 seconds for the string "F1" to appear in row 23, column 70. 

16. Message and input boxes 

PowerTerm lets the script writer create pop-up boxes for 3 purposes: messages, text 
input and password-type input. 

 Message box. 
syntax: message text [title-text] [error|question|info] 

This will pop up a box whose optional title is title-text, with the content of 
text, and with an optional icon suitable for error, question, or info. The user 
presses the OK button to continue. 

 Text input box. 
syntax: input-line text [title-text] 

This will pop up a box which includes a text input area. The box has text of 
text, and an optional title of title-text. You can assign the input to a variable as 
in: 

data = [input-line "Enter Name" "My Title"] 

 password-type input box. 
syntax: input-password text [title-text] 

This command is similar to input-line, except that the text which the user 
inputs is not echoed back to the screen. Rather, ‘*’ symbols are displayed. 

17. Sending Hex Characters. This is done via ‘/xnnn’. example: 
key f3 do {send "\x301"} 

18. Sending the Null ‘0’ Character. This is done with the special character <null>. 
example: you need to send ‘ABCZDEF’ where ‘Z’ means the NULL ‘0’ 
character. key f7 do {send "ABC<null>DEF"} 

19. Sending the ‘Enter’ key: for Unix/VMS, ‘^M’ represents the Enter/Return key. For 
IBM Mainframe/Midrange, <enter> is the way to do it. 

20. To include a filename in a script, it is necessary to use 2 backslash characters to 
represent each backslash. example: to refer to the file \tmp\myfile.txt , say 
\\tmp\\myfile.txt 

21. To access a PC environment variable within a script, use the ‘GETENV’ command. 
Here is an example: 

22. data = [getenv TMP] 
if {$data == "bernie"} {message "yes"} else {message "no"} 

23. To learn the current cursor position: 
24. get col is the command for the column 

get row is the command for the row 
25. To make a script ‘pause’ after it executes a PC program: 
26. The problem is that lines like: 

... 

... 
result = [exec MYPROG.EXE] 
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if {$result == 0} {return} 
message "The Program failed" ERROR 
... 
... 

Will not behave as expected because the script will execute the ‘if {$result == 0} 
{return}’ line immediately after starting MYPROG.EXE 

The solution is to have the script create a temp file, and to modify MYPROG.EXE to 
delete this file as its last operation. 

Then the script can be re-written as follows: 

.... 

... 
open "\\temp\\temp.dat" w 
result = [exec MYPROG.EXE] #This will erase \temp\fred.dat when it completes 
while { 1 == 1 } 

wait 1 seconds 
isfile = [file exists "\\temp\\temp.dat"] 
if {$isfile == 0} {break} 
} 

if {$result == 0} {return} ##the files does NOT exist 
message "The Program failed" ERROR 
... 
... 

27. To use the proc script command: 
28. The proc must be defined before it is used [remember, the script language is an 

interpreter.] Here is an example of usage of proc. 

proc say_hello x 
message $x 
} 

say_hello Josephine 

29. To exit PowerTerm under control of a script: 
30. exit-emulator is the command 

5. Including 'Terminal Type' & settings in an icon or script 

How do I configure PowerTerm icon to run a script or settings file? 

Sometimes it is useful to be able to make a connection and have the program commence 
operation already in a designated emulation type with various saved parameters. This is 
easy to do. First you must select the emulation and other parameters you want and save 
them via the "Save Terminal Setup as" choice from the File menu. Example: sco.pts 
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From an icon 

If you want to be able to include terminal type & settings from an icon, click here to 
download it. and copy script into the PowerTerm directory. 

Then make a shortcut or program item and supply the following parameters on the target 
line: 

example: ..... telnet2.psl xxx.pts myhost 

where myhost is the host name or IP address of the host you are trying to connect to. 

From a script 

For other users, you would just make a copy of your ‘comm.psl’ [for modem use], ‘tn5250.psl’ 
[for AS400 use], etc., and place this line: 

open-setup-file xxx.pts 

where ‘xxx.pts’ is the name of your new setup file. (This line must be the first line in the 
script.) 

Then make a shortcut or program item (as explained above) and supply the needed 
parameter hostname. 

example: ..... telnet.psl myhost 

6. DDE support - Communicating with other applications 

How do I make PowerTerm communicate with other application using DDE? 

PowerTerm supports DDE. DDE permits applications to communicate with each other. 

A DDE connection between two applications requires that one will be a server and the 
other a client. The DDE server application waits for requests from DDE clients, and allows 
them to supply it with information or receive information. 

For example: A spread sheet DDE server will let clients get data from cells and put data into 
cells of a file. 

PowerTerm can be a DDE client application or a DDE server. 

As a DDE server PowerTerm Uses the server name PTW with topic PSL. Any application can 
request it to execute commands and return the related return data. 

A client application can access PowerTerm with the DDE EXECUTE command or the DDE 
REQUEST command, and an item which is any valid PSL commands separated with ";". The 
single DDE server PSL command is: 

dde return value 

http://sc.ericom.com/demos/telnet2.zip
http://sc.ericom.com/demos/telnet2.zip
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After a DDE REQUEST commands are executed the, PowerTerm DDE server sends the value 
from the last dde return command executed in this request. If no dde return command 
executed it returns an empty answer. Examples for PowerTerm as a DDE server might be: - 
Sending information to the host. - Reading information from the emulation screen. 

As a DDE client performs one of several dde operations, depending on option. The legal 
options are: 

1) dde initiate applicationName topicName Connects to the applicationName DDE 
server with topicName. Returns a conversation id for use with successive dde 
commands. 

2) dde execute convId command Executes a server command. Return an empty string. 
3) dde request convId item Returns an item from the server. 
4) dde poke convId item value Changes an item of the server to the new value. Returns 

an empty string. 
5) dde terminate convId 

Terminates a DDE conversation with the server. 

Returns 

Returns a value according to the option. 

Example 

1. Initiates a DDE conversation with Excel for a file products.xls. Reads 3 numbers 
from the emulation screen. Puts them in three cells and gets a calculated result 
from a forth cell. Sends the result to the host computer. 

conv = [dde initiate EXCEL PRODUCTS.XLS] 

dde poke $conv R1C1 [screen-rect 1 1 10] 

dde poke $conv R2C1 [ screen-rect 2 1 10] 

dde poke $conv R3C1 [screen-rect 3 1 10] 

result = [dde request $conv R5C1] 

dde terminate $conv 

send $result 

Note: R5C1 indicates row 5 column 1. 

2. Initiate a DDE conversation with another PowerTerm with is connected to 
another computer. Reads information from the screen (of the other host) and 
sends it to its own host. 

conv = [dde initiate PTW PSL] 
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data = [dde request $conv 

dde return [screen 10 1 15 80] 

dde terminate $conv 

send $data 

Note: The command {dde return [screen 10 1 15 80]} is executed in the PowerTerm 
DDE server. 

7. Restoring the VT terminal defaults 

How do I restore the VT terminal defaults from the client side? 
If you are using a VT or an ANSI emulation you can map a key or soft-key with: 
display \033\[!p 
If you need also to clear the screen then use: 
display \033\[!p;activate-menu-item ClearScreen 

8. Sending NULL to the host 

How to send NULL to the host? In order to send NULL to the host use the following PSL 
command: 
send ^@ 
 
This command can be used for all the character mode emulations.  

9. Running PSL script commands and script files from the host 

How can I run PSL script commands or PSL script files from the host? PowerTerm and 
WebConnect HostView allow the host application to run PSL script command or PSL script 
files. In order to do this, the following escape sequences should be sent from the host (note 
that the required escape sequence is determined according to the terminal emulation 
type): 

VT Terminal Emulation: 
ESC P $ s Script-Name ESC \ 
ESC P $ t Script-Commands ESC \ 
 
Wyse Terminal Emulations: 
ESC Z t Script-Commands CR 
ESC Z s Script-Name CR  
 
 
* ESC is the ASCII 27 (Hex 1B) code. 
*    CR is the ASCII 13 (Hex 0D) code  
 
DG Terminal Emulation: 
ESC W t Script-Commands 000 
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ESC W s Script-Name 000  
 
 
*  ESC is the ASCII 30 code 
*  000 is the ASCII 0 code 
 
For example: 
Running EXEC script command in Wyse emulations: 
0x1b\Ztexec notepad\x0d 
 
Running EXEC script command in VT emulations: 
x1bP\$texec notepad\x1b 

MISCELLANEOUS  

1. URL / e-mail address hotspots. 

How can I disable the web / e-mail addresses displayed by the emulation? 
1) Open the relevant .pts file. 
2) Search for the URL-Hotspots entry and set its value to Off. 
3) Search for the Mail-Hotspots entry and set its value to Off. 
4) Save and Exit the file. Note: if those entries do not exist, please add them at the bottom of 
the file. 

2. Toggling between PowerTerm sessions 

How do I switch from one session window to another  

PowerTerm does permit ‘toggling’ from one session window to another in a rapid, 
convenient manner.  
 
The way to switch between session windows is: 

<SHIFT> <CTRL> CHARACTER 

where CHARACTER is a letter from A to Z, representing the first, second (and so on) window 
you have created.  
 
In addition, you may also use the following key combination in order to swich to the next 
session: 
<CTRL><SPACE> 

3. HLLAPI - Screen contents in a long string 

I am using the HLLAPI component and receive the contents of the expected screen in a 
long string without parsing. How can I fix this? 
 
This is the correct behavior; HLLAPI always returns the information in a string. The parsing 
process of the string should be implemented by the utility you are using. 
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4. Capturing screen data to a file 

How do I capture the screen data to a text file? 

It is very easy to capture screen data to a file. Simply use the Ascii File capture capability as 
follows: 

1) Run the Communication|Receive File menu. 
2) Choose the Ascii tab and input a filename into the text box. 
3) Press OK and proceed with your terminal session. 
4) When you want to stop capturing, run the Communication|Stop Receiving Ascii file 

menu. All screen data will be in the file whose name you supplied. 

5. Sending NULL to the host 

How to send NULL to the host? In order to send NULL to the host use the following PSL 
command: 
send ^@ 
 
This command can be used for all the character mode emulations.  

6. SSH connection with private keys 

How do I configure PowerTerm to use private SSH keys during the connection to the 
host? Please follow the steps below: 
 
1) Use an application like the "SSH-keygen" in order to generate a pair of  keys: private key 
and public key. 
2) Add the content of the new public key to the "authorized keys" file on the host. 
3) In PowerTerm’s "Connect" window: set the "security type" to "SSH" and click "Details" 
4) Set "Private key file for authentication" to the exact location of the private key generated 
in step #1. The private key does not have to be *.epk file. When doing so - PowerTerm will 
automatically create a new private key in  EPK format. 

7. PowerTerm’s HELP on Windows8 OS 

How do I enable PowerTerm’s HELP on Windows8 OS? In order to enable PowerTerm 
InterConnect HELP on Windows8 OS, please install the following Windows patch: 
http://www.microsoft.com/en-us/download/details.aspx?id=35449  

 

http://www.microsoft.com/en-us/download/details.aspx?id=35449

	PowerTerm Series Terminal Emulation - PowerTerm Lite, Plus, InterConnect, Pro, and Enterprise
	INSTALLING/UNINSTALLING, UPGRADING OR MOVING POWERTERM
	1. Including 'Terminal Type' & settings in an icon or script
	2. Release Notes
	CONNECTION AND HOST CONNECTIVITY ISSUES
	1. Creating a desktop icon for PowerTerm session
	2. Terminal ID
	3. Setting modem baud rate (speed)
	4. 'Session Type' - Requirements & Troubleshooting
	5. Creating PowerTerm shortcuts manually
	6. SNA Gateway
	7. Auto-connect via modem with a desktop shortcut
	8. Call back from a remote host
	9. Device Naming for AS/400 hosts
	10. SSH connection with private keys

	KEYBOARD, KEYBOARD MAPPING AND SCRIPT COMMANDS
	1. Mapping keys via 'drag-and-drop' or 'function button'
	2. Backspace key configuration
	3. Function Keys
	4. Key re-mapping
	5. Sending NULL to the host

	DISPLAY AND SCREEN\EMULATION DISPLAY ISSUES
	1. PowerTerm displays host application incorrectly

	LANGUAGES, SUPPORTED LANGUAGES, CODE PAGES AND CONFIGURATION
	1. Escape sequences to switch between languages (English - Hebrew)

	PRINTING, PRINTING THROUGH THE TERMINAL EMULATOR
	1. Printing Hebrew fonts
	2. Auto Printing
	3. Mainframe and AS/400 printing
	4. Define printing parameters
	5. Slave printing
	6. Transparent printing in Wyse emulation
	What are the escape sequences required for transparent printing?

	7. Postscript printer
	8. Advanced Printing - 5250 Printer parameters
	9. 'Advanced printing' and 'Host Print Transform'
	10. 'Printer Not Found' error message (v5.07 or older only)
	11. Printing to a serial printer (COM port)

	GUI CUSTOMIZATION, USER INTERFACE CHANGES
	1. Prevent the user from restoring the main menu
	2. PowerPad and Softkey programming
	PowerPad

	3. Using menu commands in script
	4. Removing GUI components (Menu, Toolbar, etc.)

	TRANSFERING FILES USING FTP OR OTHER PROTOCOLS
	1. Secure FTP - Automatic File Transfer

	SCRIPTING, POWERTERM SCRIPTING LANGUAGE AND MORE
	1. The escape sequence required in order to receive the Answerback message
	2. Automatic Login
	3. PowerPad and Softkey programming
	PowerPad

	4. Advanced script programming
	5. Including 'Terminal Type' & settings in an icon or script
	6. DDE support - Communicating with other applications
	7. Restoring the VT terminal defaults
	8. Sending NULL to the host
	9. Running PSL script commands and script files from the host

	MISCELLANEOUS
	1. URL / e-mail address hotspots.
	2. Toggling between PowerTerm sessions
	3. HLLAPI - Screen contents in a long string
	4. Capturing screen data to a file
	5. Sending NULL to the host
	6. SSH connection with private keys
	7. PowerTerm’s HELP on Windows8 OS



